
 
  

Integris Advanced Admin Manager Training Notes 



 
Integris Advanced Admin Manager Training Notes 22-Jan-19 

Page 2 of 140 

© 2019 Civica Pty Ltd 
 

Document Versions 
 

Ver. Reason Who Date 

1.0 Original Document Susan Richardson (RMA-WA) 16/11/05 

1.1 Update after DET review Susan Richardson (RMA-WA) 21/11/05 

1.2 Further updates from DET Susan Richardson (RMA-WA) 28/11/05 

1.3 Update after pilot and for 2006 Susan Richardson (RMA-WA) 20/01/05 

1.4 Requested activities added Susan Richardson (RMA-WA) 13/02/06 

1.5 Updated for 6.85 Sidney Loke (RMA-WA) 18/07/06 

1.6 Amended after DET review Sidney Loke (RMA-WA) 24/07/06 

1.7 Updated for 6.86 and 2007 Megan Capicchiano (RMA-WA) 09/01/07 

1.8 Updated following DET review Adam Catterall (RMA-WA) 16/01/07 

1.9 Updated with final changes Megan Capicchiano (RMA-WA) 19/01/07 

2.0 Updated for 2008 Susan Richardson (RMA-WA) 21/01/08 

2.1 Corrected for 2008 Anthony Harris (RMA-WA) 21/01/08 

2.2 Minor Corrections Shauna Henry (RMA-WA) 03/04/08 

2.3 
Updated for 6.88 with minor 
amendments 

Shauna Henry (RMA-WA) 14/07/08 

2.4 Updated for 2009 Susan Richardson (RMA-WA) 27/11/08 

2.5 Updated following DET review Joshua Kragt (RMA-WA) 16/01/08 

2.6 Update for 6.89 Joshua Kragt (RMA-WA) 22/09/09 

2.7 Updated for 2010 & Version 6.90.21 Joshua Kragt (RMA-WA) 09/12/09 

3.0 
Proofed with minor corrections and 
editing 

Shauna Henry (RMA-WA) 15/12/09 

3.1 Updated for 6.91.10 Joshua Kragt (RMA-WA) 17/12/09 

3.2 Updated following DET review Joshua Kragt (RMA-WA) 08/01/10 

4.0 Updated for Version 6.92.10 Shauna Henry (RMA-WA) 28/06/10 

6.0 
Minor corrections, matched version 
and new template attached 

Derek Mathieson (RM Ed) 24/09/10  

7.0 Updated for 6.93.10 and 2011 Derek Mathieson (RM Ed) 27/01/11 

8.0 Updated for 6.94.10 Derek Mathieson (RM Ed) 15/07/11 

9.0 Updated for 2012 Derek Mathieson (Civica Education) 04/04/12 

10.0 Updated for 6.96.10 Derek Mathieson (Civica Education) 04/07/12 

11.0 Updated following training Derek Mathieson (Civica Education) 28/09/12 

12.0 Updated for 6.97.10 and 2013 Derek Mathieson (Civica Education) 15/01/13 



 
Integris Advanced Admin Manager Training Notes 22-Jan-19 

Page 3 of 140 

© 2019 Civica Pty Ltd 
 

Ver. Reason Who Date 

13.0 
Reviewed for 6.98.10 
Formatting changes only 

Susan Richardson (Civica Education) 17/07/13 

14.0 Updated for 6.99.10 and 2014 Derek Mathieson (Civica Education) 31/01/14 

15.0 Minor corrections after training Shauna Henry (Civica Education) 06/03/14 

16.0 Updated for 7.00.10 Derek Mathieson (Civica Education) 30/06/14 

17.0 Updated for v7.03.10 and 2015 Shauna Henry (Civica Education) 07/07/15 

18.0 Minor Update prior to Training Derek Mathieson (Civica Education) 01/10/15 

19.0 Updated for v7.05.10 and 2016 Derek Mathieson (Civia Education 20/04/16 

19.0  Updated for v7.09.50 and 2019 Shauna Henry (Civica Education 22/01/19 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Civica Pty Ltd ACN 086 405 174 
Copyright  

 MMXlX 
All Rights Reserved 

This document is the property of Civica Pty Ltd and may not be 
copied, transmitted or reproduced by any means 
without the written permission of Civica Pty Ltd. 

  



 
Integris Advanced Admin Manager Training Notes 22-Jan-19 

Page 4 of 140 

© 2019 Civica Pty Ltd 
 

 

Copyright 
 
All rights are reserved.  No part of this document may be reproduced or transmitted in any form or 
means electronic or mechanical including photocopying and recording or by any information 
storage or retrieval system except as may be permitted in writing by Civica Pty Ltd (trading as 
Civica Education).  
  
Application for permission for use of copyright material, including permission to reproduce extracts 
in other published works, shall be made to the publishers.  Full acknowledgement of author, 
publisher and source must be given. 
  
Material is contained in this publication for which publishing permission has been sought and for 
which copyright is acknowledged. Permission to reproduce such material cannot be granted by the 
publishers and application must be made to the copyright holder. 
  
Microsoft, Windows and Excel are registered trademarks of Microsoft Corporation.  Visual 
Components is a trademark of OMNIS Software Limited.  Integris is a trademark of RM Plc. 
  
Because our policy is to improve our products and services continually, we may make changes 
without notice.  We have tried to keep the information in this manual complete and accurate, but 
we cannot be held responsible for the consequences of any errors or omissions. 
  
Your comments are of great value to us in improving our computer systems, publications and 
services. 

 

Intellectual Property  
 
The contents, design, solutions and plans contained in this document represent the intellectual 
property of Civica Pty Ltd (trading as Civica Education) and its associates. All rights are reserved 
except as may be granted to the addressee in writing by Civica Education. 
 
   



 
Integris Advanced Admin Manager Training Notes 22-Jan-19 

Page 5 of 140 

© 2019 Civica Pty Ltd 
 

Contents 

1 Introduction .......................................................................................................................... 7 
1.1 What is Administration Manager? ......................................................................................... 7 
1.2 Training Program .................................................................................................................. 8 
1.3 Training Outcomes ............................................................................................................... 9 
1.4 Logging On to the System .................................................................................................. 10 
1.5 The File Menu .................................................................................................................... 11 
1.6 Accessing Help .................................................................................................................. 12 
1.7 System Preferences ........................................................................................................... 13 

2 Parameters ......................................................................................................................... 14 
2.1 Managing Parameters ........................................................................................................ 14 
2.2 Activity Parameters ............................................................................................................ 14 

2.2.1 Student Activity Types ..................................................................................................................... 15 
2.2.2 School Activity Types ....................................................................................................................... 16 
2.2.3 Adding Student Activity .................................................................................................................... 17 
2.2.4 Student Activities Report ................................................................................................................. 19 
2.2.5 Adding School Activity ..................................................................................................................... 20 
2.2.6 Editing School Activities ................................................................................................................... 22 

3 Maintaining Student Details ................................................................................................ 23 
3.1 Revising Student Find ........................................................................................................ 23 

3.1.1 Using the Previous Student/Next Student Arrows ........................................................................... 23 
3.1.2 Quick Search ................................................................................................................................... 23 
3.1.3 Make Siblings the Browse Set ......................................................................................................... 24 
3.1.4 Find Student .................................................................................................................................... 24 
3.1.5 Advanced Find Student Search ....................................................................................................... 28 
3.1.6 Saving a Query ................................................................................................................................ 31 

3.2 Editing Student Records ..................................................................................................... 32 
3.2.1 Family Mail Marker .......................................................................................................................... 32 
3.2.2 Flagging Family Mail Markers .......................................................................................................... 33 
3.2.3 Print Family Mail Markers ................................................................................................................ 34 
3.2.4 Editing Parent/Guardian Addresses ................................................................................................ 35 

3.3 Family Representatives ...................................................................................................... 36 
3.3.1 Flagging Family Representatives .................................................................................................... 37 
3.3.2 Linking Siblings ................................................................................................................................ 39 
3.3.3 Family Representative List .............................................................................................................. 40 

3.4 Updating a Medical Record ................................................................................................ 42 
3.5 Medical Reports ................................................................................................................. 45 

3.5.1 Medical Details Report ..................................................................................................................... 45 
3.5.2 Medication Report ............................................................................................................................ 46 
3.5.3 Health Care Conditions Review Date .............................................................................................. 47 

4 Managing the Rolls ............................................................................................................. 48 
4.1 Entering Student Details in the Admissions Roll ................................................................. 48 
4.2 Transfer Students from Admissions to the Current Roll ...................................................... 52 
4.3 Moving Students to the Former Roll ................................................................................... 54 

4.3.1 Moving an Individual Student to the Former Roll ............................................................................ 54 
4.3.2 Re-Admissions Form ....................................................................................................................... 56 
4.3.3 Moving Multiple Students to the Former Roll ................................................................................... 57 

4.4 Assigning Schools Curriculum and Standards Authority (SCSA) Student Numbers ............ 60 

5 Exporting and Importing Student Data ................................................................................ 63 
5.1 Exporting Student Information ............................................................................................ 65 

5.1.1 School to School Export .................................................................................................................. 65 
5.1.2 Students Details XML Export ........................................................................................................... 66 

5.2 Importing Student Data....................................................................................................... 69 
5.2.1 School to School Import to the Admissions Roll .............................................................................. 69 

5.3 Moving Students to the Current Roll ................................................................................... 71 
5.3.1 School to School Import to the Current Roll .................................................................................... 73 



 
Integris Advanced Admin Manager Training Notes 22-Jan-19 

Page 6 of 140 

© 2019 Civica Pty Ltd 
 

5.4 Advanced Admissions Batch Entry ..................................................................................... 75 
5.5 Moving Admissions Batch Students to the Current Roll ...................................................... 81 

6 The External Roll ................................................................................................................ 83 
6.1 External Roll Active ............................................................................................................ 83 
6.2 Adding a Student to the External Roll ................................................................................. 84 

7 Mail Merge ......................................................................................................................... 86 
7.1 Introduction to Mail Merge .................................................................................................. 86 
7.2 Mail Merge: kst format ........................................................................................................ 88 

7.2.1 Creating a kst Template ................................................................................................................... 88 
7.2.2 Using the kst template to create letters ........................................................................................... 90 

7.3 Mail Merge using csv format ............................................................................................... 93 
7.3.1 Create an Export (.csv)  File ............................................................................................................ 93 
7.3.2 Creating a Mail Merge Letter in Word .............................................................................................. 96 
7.3.3 Using the Mail Merge Wizard........................................................................................................... 99 
7.3.4 Create Student Activity Record for Letter Sent.............................................................................. 104 
7.3.5 Create Address Labels .................................................................................................................. 106 

8 User Defined Information .................................................................................................. 110 
8.1 Create a UDI .................................................................................................................... 110 
8.2 Speed Edit UDI ................................................................................................................ 113 
8.3 Ad Hoc Reports ................................................................................................................ 114 

8.3.1 Simple Ad Hoc Reports ................................................................................................................. 116 
8.3.2 Normal Ad Hoc Reports ................................................................................................................. 118 

9 Admin Reports ................................................................................................................. 121 
9.1 General Reports ............................................................................................................... 121 

9.1.1 Medical Conditions ........................................................................................................................ 121 
9.2 Roll Reports ..................................................................................................................... 122 

9.2.1 Parent/Guardian 1 Phone and Address ......................................................................................... 122 
9.3 Form Lists ........................................................................................................................ 123 

9.3.1 Student Information Card ............................................................................................................... 123 
9.4 Check Lists ....................................................................................................................... 124 

9.4.1 Group Checklist ............................................................................................................................. 124 
9.5 Address Labels ................................................................................................................ 125 

9.5.1 Family Mail ..................................................................................................................................... 125 
9.6 Exports ............................................................................................................................. 126 

10 Timetable Reports ............................................................................................................ 127 
10.1 O&M Reports-Teaching Sets ............................................................................................ 127 

10.1.1 User Defined Teaching Set Lists ............................................................................................... 127 

11 WA Reports ...................................................................................................................... 129 
11.1.1 Standard Student Checklist ....................................................................................................... 130 
11.1.2 Student Profile Report ............................................................................................................... 135 
11.1.3 Student Health Care Summary (Form 1) ................................................................................... 137 

12 Index ................................................................................................................................ 138 

13 Support ............................................................................................................................ 140 
13.1 Phone (CSC) .................................................................................................................... 140 
13.2 Fax (CSC) ........................................................................................................................ 140 
13.3 Email (CSC) ..................................................................................................................... 140 

14 Online Manuals and Training Notes.................................................................................. 140 
14.1 Civica ............................................................................................................................... 140 
14.2 STIMS Project .................................................................................................................. 140 
 



 
Integris Advanced Admin Manager Training Notes 22-Jan-19 

Page 7 of 140 

© 2019 Civica Pty Ltd 
 

1 Introduction 
These Training Notes provide a reference during and following Civica Education’s Advanced 
Administration training.  
 
They cover:  

 Maintaining Student Details 

 School-to-School exports and imports 

 User Defined Information 

 Mail Merge 

 Checklist and Ad Hoc Reports 
 
The Administration Manager Software Manual provides a comprehensive guide to the software.  
 
During training we will be working with fictitious data and all the exercises contained within this 
user guide refers to that data. 
 

1.1 What is Administration Manager? 

Administration Manager is a Windows-based database that enables schools to keep detailed 
student and staff records and use these records to produce a wide range of reports. Student data 
is stored in four data sections – Admissions, Current Roll, External Roll and Former Roll.  Each 
student record is divided into several sections such as personal, additional information, activities, 
attendance history, medical details and teaching sets. There is also an Emergency feature for fast 
access to student data. 
 
Other functions include Speed Edit, Control functions, the Year End function, Admissions, and 
Standard and Ad Hoc Reports. 
 
The system is relatively easy to use and maintain. Administration Manager is a powerful tool that 
provides administrators smooth access to information, which is easy to use and has a well- 
structured, logical layout. 
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1.2 Training Program 

 

Time Content 

9.00 am Help 

Parameters (Student and School Activity) 

Adding Student Activity 

Adding School Activity 

Viewing the School Diary 

Locating Students 

Maintaining Student Details 

Printing Family Representatives 

10.30 am Morning Tea 

10.50 am Entering Student Details in the Admissions Roll  

Moving Students to the Former Roll 

Exporting Student Details 

Importing Student Details 

Transfer students to the Current  Roll 

12.30 pm Lunch 

1.00 pm Mail Merge 1 (Using .kst templates) 

Mail Merge 2 (Using MS Word and csv data) 

Mail Merge Labels 

Speed Edit 

User Defined Information 

Ad Hoc Reports  

2.50 pm Admin Reports 

WA Reports 
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1.3 Training Outcomes 

 
At the end of training participants will be able to: 
 

 Maintain Parameters 

 Use Student and School Activity 

 Use Simple Student Search and Student Find 

 Maintain Student Details 

 Maintain and report on Family Representatives details 

 Enter Student Details in the Admissions Roll 

 Move Students to the Former Roll  

 Export Student Details  

 Import Student Details to existing students on the Current Roll 

 Create Mail Merge letters using a .kst format and a.csv format  

 Create Mail Merge letters using MS Word and a csv datafile 

 Create Labels 

 Create User Defined fields 

 Create an Ad Hoc Report  

 Create Admin Reports 

 Create Checklist Reports 

 Create a Student Profile Report 
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1.4 Logging On to the System 

Activity 
 

 To log on, double click on the Integris Training icon on the desktop 
 

 
 

 Type ADMIN as the User Name for use in today’s training 

 Press <Tab> to move the cursor to the Password box  

 Enter the password: keys 
 

 
 

 Click on Login or press <Enter>  
 

 
In schools, each user has their own user name and password, which enables access to particular 
sections of the software as determined by the school administration. 

Note: It is strongly recommended that you change your password once a month. 
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1.5 The File Menu 

The file menu may be accessed by clicking on File in the top left of your screen. 
 

 
 

 Password enables the user to change his or her password.  For security purposes, it is 
recommended that this is done regularly. 

 Change User should be used to ensure that each person accessing Integris does so under 
their own user name and with their personal levels of access. 

 Lock Terminal may be used if the user needs to leave his or her computer temporarily, does 
not want to log off and does not want to allow access to anyone else.  Unlocking the terminal 
requires the user to enter his or her password again. 

 Report Destination allows the user to choose where to send any report created in Integris.  
The options are displayed below. 
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Activity: The File Menu 

Top Toolbar > File 

View each of the following items in the File menu 

 Password 

 Change User 

 Lock Terminal 

 Report Destination 
 

 

1.6 Accessing Help 

Activity: Accessing Help 

Top Toolbar > Help > Help Contents and Index 

 Click Help in the top toolbar  

 Select Help Contents and Index  
 

 
 

 Highlight Integris Administration Manager Help  

 Click Help  

 View the manual  

 Close the manual and Help  

Note: <Ctrl + F> allows you to search a document for a specific topic or go to Edit and 
Search to open a search window 
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1.7 System Preferences 

General > Control > Preferences > eMail/Web/Login 

Schools can now add a Staff Notice for staff when they first login to Integris each day. A photo 
from your school can also be added. 
 

 
 

 Click on the magnifying glass  

 Navigate to C:\keys\Integris\Photos\NoticesPhoto2.jpg to select a new photo 

 Click OK 

 Click on File > Change User and log back in as ADMIN and keys to see the change 

Note: The Recommended size for jpeg files is 600x350 pixels  

General > Control > Preferences >Reports 

 Tick the box to Display Report Location Footers 
 

 
 

 Click OK 
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2 Parameters 

General > Parameters  

Various windows within Integris contain fields with information.  Some of these fields have drop-
down menus.  The items in these drop-down menus are referred to as Parameters.  In other 
words, many fields are completed by choosing values from a list.  For example, when adding a 
staff member’s Indigenous Status a user cannot simply type in Aboriginal, it must be selected 
from a pre-defined list.  These lists are set up in Parameters.  

Note: The length of Parameter codes is set up in Control > Preferences > General > 
Parameter ‘code’ digits. 

The Department of Education (DoE) manages several data fields.  These fields must not be edited 
or added to.  DoE will ensure that these key parameter fields are updated as required. The 
managed fields are: 

 

 Allowance Type 

 Country of Birth 

 First Language 

 Indigenous Status 

 Previous/Destination School 

 Religion  

 Year Groups 

 VISA Sub Class Numbers 
 

2.1 Managing Parameters 

Some Parameters assist is adding and maintaining meaningful information about students and also 
the school. 
 

2.2 Activity Parameters 

The Student Activity screen in General>Student Details can be used to add further information 
about students and activities relating to them. 
 
The School Activity screens in General>School Details>School Diary can be used by schools to 
manage their activities and events within a calendar. 
 
Parameters can be added to categorise the Student and School Activity information 
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2.2.1 Student Activity Types 

Activity 

General > Parameters > Student Activity Types 

 Add the activity type Parent Contact 

 Right click in the list of Student Activity Types  

 Select Add New Parameter 
 

 
 

 Enter PC as the Code 

 Enter Parent Contact as the Description 
 

 
 

 Click OK  
 

 
 

 Close the Student Activity Types window 
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2.2.2 School Activity Types 

Activity 

General > Parameters > School Activity Types 

 Open School Activity Types 

 Right click in the list of School Activity Types 
 

 
 

 Select Add New Parameter 

 Enter INC as the Code 

 Enter Incursion as the Description 
 

 

 Click OK  
 

 
 

 Close the School Activity Types window 
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2.2.3 Adding Student Activity 

Activity:  
 
Alecia Bishop’s mother has contacted the school to request a meeting to discuss Alecia’s 
attitude to school. Record this in the Student Activity screen. 
 

General > Student Details 

 Find Alecia Bishop 
 

 
 

 Click on the Student Activity Icon  

 Click on the Edit pencil  

 Click on Add New Record  

 Use today’s date 

 Add details of the contact as shown below 
 

 
 

 Click OK 

 Highlight the Activity to view the details 
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 Add a further record as shown below  
 

 
 

 Click OK and Print to view details in a report 

 Click OK to save and finish 

Note: Student Activity Records can be printed from the main Student Activity display 
screen for individual students and can also be printed while in Edit Mode.  To report on 
multiple student’s activity use the Report in Admin > Reports > General Reports.  

  



 
Integris Advanced Admin Manager Training Notes 22-Jan-19 

Page 19 of 140 

© 2019 Civica Pty Ltd 
 

2.2.4 Student Activities Report 

Activity 

Admin > Reports > General Reports > Student Activities Report 

 Check the box Sort by Student 

 Check the box Show Activity Details 

 Enter Both in the Completion Status 

 Click the  tab 

 Find the Year 8 students 
 

 
 

 Click Print and OK to print to the screen 
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2.2.5 Adding School Activity 

Activity 

General > School Details > School Diary 

Constable Care will be attending the School for 3 afternoons for performances regarding 
Bullying. 
 

 Click on Display School Diary   

 Click on Year View   

 Select August 20th 

 Click on  to add an activity 

 Select Incursion from the School Activity Type drop down menu 

 Enter 13:00 to 15:00 as the times 

 Enter the other details as shown below 
 

 
 

 Click OK 

 View the Activity 

 Click on Recurring Events  

 Add 2 further occurrences 
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 Click on Generate and view the message 
 

 
 

 Click Yes 
 

 Click on  to view a Term Calendar 

 Select Term 3 and Select All Types 
 

 
 

 Click on Print 

 View, then close the Calendar and Close the Term View Report window 
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2.2.6 Editing School Activities 

Activity 

General > School Details > School Diary > Year View 

 Select Monday 21st October 

 Highlight the Spare Parts Puppet Theatre Incursion 

 Click Edit  

 Change the Activity Type to Incursions 

 Add the required Notes 
 

 
 

 Click OK 

 Click on  to view a Term Calendar 

 Select Term 4 and Incursions 
 

 
 

 Click Print 

 View and close the calendar 

 Close the Diary and School Details 
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3 Maintaining Student Details 

3.1 Revising Student Find 

General > Student Details 

There are five methods of searching for students in Student Details 
 

 Using the Previous Student/Next Student arrows 

 Using Quick Search 

 Making Siblings the Browse set 

 Using the standard Integris Find Student function  

 Using the Advanced Find Student Search  
 

3.1.1 Using the Previous Student/Next Student Arrows   

The Previous Student/Next Student arrows are located at the top left of the Student window. 
 

 
 
They can be used to scroll through the current browse set of students.  

Click on the Next Student arrow  to move to the next student in the browse set. Click on the 

Previous Student arrow  to move to the previous student in the browse set. 
 

3.1.2 Quick Search    

The Summary screen in Student Details provides a Simple Student Search facility to enable the 
user to quickly locate and load a specific student’s record. It is located at the bottom left corner of 
the Student window.   
 

 
 
The search operates on the currently defined browse set in the Student Details window. If no 
browse set is defined, the currently selected roll will be searched. 

 

Activity 

General > Student Details 

 Place your cursor in the Search box or tab to the field to activate it  

 To search for a student Kane Smith enter the following:   

 Press <Tab> 
 
The Student Details screen for Kane Smith is displayed. 
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 Use the Simple Student Search to locate William Green’s record 
 

 Repeat to locate Jackie Albert’s records 
 

 

3.1.3 Make Siblings the Browse Set  

Once a student’s record is loaded, and any necessary changes have been made, it is easy to 
create a browse set of the student’s siblings so that the siblings’ records can be edited.  In the 
Contacts pane, right click and select Make Siblings the Browse Set.  
 

Activity 

General > Student Details 

 Right click in the contacts pane for Jackie Albert 
 

 
 

 Select Make Siblings the Browse Set 
 

 Indicates that a Browse Set (a subset of student records) has been created. 
 

 Click Next Student  
 
Jennifer Zolter-Albert’s records will be displayed. 
 

 Click Previous Student  to return to Jackie’s records 
 

 Click  and Yes to clear the browse set 
 

 

3.1.4 Find Student    

Another method of finding a student’s record is by using the standard Find Student  function 
located at the top of the Student window. This function is used in other sections of Administration 
Manager and in other Integris modules.  
 
Use the Find Student tool to select students by a variety of different search criteria. Click on the 
Find Student icon and the following window appears. 
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Find a particular student by entering either a surname or Student Reference number in the 
Name/Number field.  It is not necessary to enter the whole surname.  Enter the first few characters 
and press <Enter>.  A list of students’ names matching the characters entered will be displayed.  
Double click on the appropriate name. 
 
You can find individual students or groups of students by many other criteria such as year group, 
form, teaching set, group, previous school, indigenous status, dates (including birthdays and 
students’ ages), addresses and user-defined information (UDI). 
 

Activity 

Search for students 15 years and older 

 Select the Dates tab 

 From the drop down list select Student Age criteria  

 Click the  button to change it to the  

 Enter the age 15 

 Enter TODAY’S date 
 

 
 

 Click Find or <Enter> 

 Sort by Date of Birth column 

 Click  to view a report 
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Find students with a Health Condition 

 Find the students who have an Allergy - Anaphylaxis 

 

 Click Find or <Enter> 

 Click Back and clear your settings  
 

Search for Students with a Measles Exclusion 

 Select the UDI tab 

 Choose the option Equals from the dropdown list and type Yes in the third column 
 

 
 

 Click Find or <Enter> 

 Sort by Year Level then Print  
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Find students In Care of DCP 

 Select the Dates tab 
 

 
 

 Click Find or <Enter> 

 Click Back and clear your settings  
 

Find the Students with an Access Restriction 

 Click on the Parameters Tab 
 

 
 

 Click Find or <Enter> 

 Click Back and clear your settings 
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3.1.5 Advanced Find Student Search  

When searching for students the Advanced Find Student Search  tool can be used to add 
another student or group of students to an existing search results list. 

For example, a normal student search could be performed using the   tool.  Once the desired 
list of students is displayed the Advanced Find Student Search tool could be used to add more 
students to the existing list. 
 

Activity 

Find the Year 8 and 9 Boys 

 Click Find  

 On the General tab, select Year Group: 8 
 

 
 

 In the Parameters tab, select Gender: Male 
 

 
 

 Click Find or <Enter> 
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 Click Advanced Find  to search for the additional students to add to the query 

 Click Add Students  to find for the Year 9 boys  
 

 
 

 Select the Parameters tab and Gender – Male 
 

 
 

 Click Find, Select and Yes 

 This will add the Year Nine boys to the Year 8 list 
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 Click on the Form column header to sort into Forms 

 Click Print  and send the report to the screen 

 Close the report 
 

 Click Select and Yes to create a browse set of Year 8 and 9 boys 

 Clear  the browse set by clicking on  
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3.1.6 Saving a Query 

The system can save any search criteria you enter - this is called a Query. A query can then be 
used at a later date to save you setting up the search again. 
 

Activity 
 
Find the students who are the Family Representatives 
 

 Click on the Address tab 

 Select the Family Representative radio button 
 

 
 

 Save  this query 

 Give it an appropriate name and click OK 
 

 
 

 Close the Student Search window 
 

To use the saved search query. 

 Click Find Student  

 Click View the Query List  

 Highlight Family Reps 

 Click Load and Find to locate the students matching the query 
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Note: Saving a query saves the question not the answer.  Every time the query is loaded, an 
up-to-date list of the students matching the search criteria is displayed. 

3.2 Editing Student Records 

3.2.1 Family Mail Marker 

General > Student Details > Family Group 

The Family Mail Marker field should be enabled if letters are to be sent to the parent/guardian at 
this address.  If this field is used, ensure you complete the salutation. Enter the salutation that is to 
be used when writing a letter to this person.  It is also displayed on some reports. 
 

 
 
In the example above, the student has details of both parents recorded, with only one 
parent/guardian (the mother) nominated as a family mail marker.  The salutation Mr and Mrs Albert 
will be available as a mail merge field. 

Note:  When entering the Salutation for multiple parents ‘and’ must be used not ‘&’.  Refer 
to the Departments Guidelines for Data Entry Procedures document for further information 

on data entry procedures. 
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3.2.2 Flagging Family Mail Markers 

Activity 

General > Student Details 

 Use the Search field to locate Adam Alkitik’s record 
 

 
 

 Click Edit  

 Select the Family Group tab 

 Select Parent/Guardian1 

 Edit the Salutation to read Ms Alkitik 
 

 Select Parent/Guardian2 

 Check Family Mail Marker 

 Edit the Salutation to read Mr Alkitik 
 
This will ensure that both Parent/Guardians will receive all correspondence issued, regarding 
Adam. 
 

 
 

 Click OK to save 
 

Both of Jordan Corey’s parents wish to receive correspondence regarding his schooling. 

 Flag Jordan’s father as a Family Mail Marker 

 Enter an appropriate Salutation for Jordan’s father 
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3.2.3 Print Family Mail Markers 

A Report can be printed to display all students and their Family Mail Markers.  
 

Activity 

WA Reports 

 Click on the Profile Icon at the tiop of the screen  

 Scroll down and highlight the Family Mail Marker List 

 Click on New Query and then Find, Select and Yes to load the Current Roll 
 

 
 

 Click Print 

 View and close the Report 

 Re-Print the Report using some of the additional options 
 

 
 

 View and close the Report 
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3.2.4 Editing Parent/Guardian Addresses 

Activity 
 

 Find Emily Gold 

 Click Edit 

 Select the Family Group tab 

 Select Parent/Guardian1 

 Click Edit  
 

 Select Specific address 

 Enter the address information below 
 

 
 

 Click OK 
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3.3 Family Representatives 

Family Representative flags a student as being the one who, for example, is given newsletters on 
behalf of a family.  The field differs from the Family Mail Marker in that the field is attached to the 
student, rather than to the student contacts. 
 
One or more members of a sibling group may be flagged as Family Representatives, although it is 
anticipated that the marker will usually be attached to the eldest or youngest sibling enrolled at the 
school. 
 
The Family Representative Field is available in the personal area of the Student window. 
 

 
 
If a student is added to the database and they are to be the family representative for a sibling 
group, mark the Family Representative checkbox.  This will not overwrite any sibling already 
flagged as family representative. 
 
To ensure that all family groups have a family representative, go to Admin > Utilities > Assign 
Family Representatives and choose the options that suit your needs. 
 

 
 
Press OK to run the function. 

Note: This function needs to be run in Single User mode. 
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3.3.1 Flagging Family Representatives 

Activity 

General > Student Details 

 Use Search to locate Kristof Farmer’s records 
 

 
 

 Right click in the Contacts pane and select Make Siblings the Browse Set 
 

 
 

 Click Next Student  to view Kirsty Farmer’s records 
 
Which sibling is the Family Representative?  Who is the youngest? 
 

Note: Assigning Family Representatives in this way requires that only a single user is 
logged on. 

File > Single User Lock 

 
 

 Enter your password keys and click OK 
 

 
 

 Click OK again 
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Admin > Utilities > Assign Family Representative 

 
 

 Select the options below 
 

 
 

 Click OK and Yes 

 Click OK 

 Close Administration Utilities 
 

Restore Multi-user 

 Click Locked in Single User Mode  

 Click Restore Multi-user 

 Enter keys and click OK 
 

General > Student Details 

 Load Kristof and Kirsty Farmer’s records 

 Check to see who is the Family Rep 
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3.3.2 Linking Siblings 

Activity 

General > Student Details 

Brenton Em and Lance Em are siblings. This needs to be updated in Student Details. 
 

 Find Brenton Em 

 Click Edit  

 Click the Family Group tab 

 Click the Siblings tab 

 Click Add sibling relationship  

 Leave the Search Criteria as Same Surname 
 

 
 

 Click Find 

 Highlight Lance Em, click Select 

 Click OK to save 
 

 Right click in the Contacts pane and select Make Siblings the Browse Set 

 Click Next Student  to check that Lance has been added as a sibling to Brenton 

 Click  

 Uncheck  

 Click OK 
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3.3.3 Family Representative List 

Activity:  

WA Reports > Reports > WA Reports > Family Representative List 

 
 

 Click the Sort tab 

 Sort first by Form and then by Surname 
 

 
 

 Check Total and Page for Form 
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 Click the Select tab 

 Select Form 
 

 
 

 Click Select All  

 Click Includes 

 Check Selection Criteria and Form Teachers 
 

 
 

 Print the report  to the screen 

 Click Save as a Custom Report  
 

 
 

 Close the report and WA Reports 
 

 
 
  



 
Integris Advanced Admin Manager Training Notes 22-Jan-19 

Page 42 of 140 

© 2019 Civica Pty Ltd 
 

3.4 Updating a Medical Record 

Activity 

General > Student Details 

We have been advised that Aimee Futterby requires an update to her Medical Records. Produce 
a Form 7 Seizures Form for her parents 
 

 Find the student Aimee Futterby 

 Click Send Letter   

 Use the Mailing Options Shown 
 

 
 

 Click OK and click on up one level   

 Navigate to the Student Health Care Plan folder 

 Double click on the Form 7 Seizure document 

 Click Yes to send a copy of the letter to the student’s activity log 
 
On return of this form we can update Aimee’s details 
 

 Click  and Edit Student  

 Select the SHCS and SP’s tab  

 Aimee’s SHCS has been completed and she has completed a Seizures Plan as of 
YESTERDAY  

 

  
 

 Mark the Medical Details Tab as shown below 
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 Select the Health Care Planning tab  

 Highlight the Health Condition and click Edit  and enter the information displayed below 

 Enter the Emergency Response Plan information under the existing note 

Note: The Emergency Response Plan can be copied and pasted from Form 7 Seizure.kst 
which can be found in the following location C:\keys\Integris\MMTPL\Student Health Care 
Plan.  

 
 

 Check the information entered, then click OK   
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 Click Open Medication Details  and Add Medication   

 Enter the Medication information as displayed below  
 

 

 Add an Expiry Date 

 Check the information entered, then click OK  twice 
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3.5 Medical Reports 

There are several Medical Reports in Admin > Reports that can be used by schools to display 
Medical Information about students. 

3.5.1 Medical Details Report 

Activity  

Admin > Reports > General Reports > Medical Details 

 Sort by Year Level 

 Tick all the boxes 

 Click New Query and Find Select and Yes to load all students on the Current Roll 
 

 
 

 Click Print 
 

 

Note: By selecting the option to Only include students with ‘flagged’ health conditions, and 
then selecting your whole school, this report will only Print those students who have their 
condition flagged on the Status Bar. 
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3.5.2 Medication Report 

Activity  

Admin > Reports > General Reports > Medication Report 

 Sort by Form then Year 

 Click New Query 

 Find All Current students 

 Print to the screen 
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3.5.3 Health Care Conditions Review Date 

Activity  

Admin  > Reports > General Reports > Health Care Conditions Review Date 

 Select Plans ALL. 

 Print to the screen 
[All students with a Health Care Condition Plan will be selected for the Report] 
 

 
 

Note: Entering From and To Dates will allow filtering to include only students who have 
Completed Dates and Review Dates entered in the report window 
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4 Managing the Rolls 

4.1 Entering Student Details in the Admissions Roll 

While it is recommended that schools use the school to school export and import processes to 
enrol new students, for any number of reasons this is not always possible.   In these instances, 
students’ details will need to be entered manually. 
 

Activity 
 
Joshua Burnett will be starting at the school next week.  His mother has completed his 
enrolment form today.  We do not have his details from his previous school. 

General > Student Details 

 Select the Admissions roll   

 Click Add Student   

 Type Burnett  in the surname field and <Tab>  

 Cancel Choose Siblings 
 

 Enter Joshua’s personal details 
 

 
 

 Check Family Representative  
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 Select the Family Group tab 

 Enter his mother’s  details in Parent/Guardian 1 
 

 

Note: Do not use ‘&’ in the Salutation field for multiple parents. 

 Click Add Notes  on the right 

 Enter the mother’s work information  
 

  
 

 Click OK 
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 Select the Additional tab  

 Check   

 Check Birth Certificate Seen and add Australia as the Country of Birth 

 Enter TODAY’s date as the date Joshua’s Birth Certificate was checked 
 

 

 Select the Movement History tab and click Add  

 Enter the To date as YESTERDAY (or last Friday)  

 Enter the previous School and Reason 
 

 
 

 Click OK  

 Select the Medical tab 

 Select a Medical Practice 

 Enter a Doctor’s name 

 Tick the SHCS Completed box (Student Health Care Summary-Form 1) and add today’s 
date 
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 Click the Medical Details tab  

 Check Permission to Call Doctor and Permission to Administer First Aid 
 

 
 

 Select the Health Care Planning tab   

 Add  and enter Joshua’s medical condition as below, then click OK 
 

 
 

 Click on the Miscellaneous tab   

 Under Immunisation Details, check the Evidence Provided box 
 

 
 

 Enter Today’s date as Date Checked 

 Select Fully Completed for the Vaccination Schedule 

 Untick the Measles Exclusion box  

 Click OK  to save the record 

 Click Yes if a Timetabling message appears 
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4.2 Transfer Students from Admissions to the Current Roll 

Activity 
 
Joshua is ready to start at the school.  We can mark him as Accepted on the Admissions Roll. 
 

 Click the Summary folder to return to his home page 
 

 Click Edit   

 Check Accepted 
 

 
 

 Click OK 

 View the Accepted Icon  on the Status Bar 
 

 
 

 Close Student Details 
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Admin > Utilities 

 Double click Admissions Transfer > Current Roll 
 

 
 

 Select the second  option  (ignoring  any entry dates) and leave TODAY as the Entry Date 

Note: If the first option is selected, only those accepted admissions students whose Entry 
Date matches the date of entry will be transferred to the current roll. 

If the second option is selected, ALL accepted admissions students will be transferred to 
the current roll and any Entry Date previously entered will be ignored and be replaced by 
the date entered in this window. 

 Click Next 
 

 

Note: Students can be deselected if they have not arrived at school 

 Click Finish and OK 

 Click No as we will not check for empty batches at this point 
 

General > Student Details 

 Locate Joshua Burnett on the Current roll 
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4.3 Moving Students to the Former Roll 

Students may be moved from the Current to the Former roll individually or in groups. 
 

4.3.1 Moving an Individual Student to the Former Roll 

Activity  
 
Linda So is leaving the school today. 

General > Student Details 

 Select the Current Roll 

 Use the Search field to find Linda So 

 Click on Move Student to Former Roll   

 Click Yes to move her to the Former Roll 

 Leave the Leave Date as TODAY and enter the following details 
 

 
 

 Click OK 

 Select TODAY’s date regarding changes to the roll status (the default date is the date up to 
which Daily Records have been created) 

 

 
 

 Click OK 
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 Remove her from her cohorts by clicking  
 

 
 

 Click Yes 

Note: Removing students from their cohorts in this way, enables the Timetabling module 
to keep a record of their teaching sets. 

Linda’s records have now been moved to the Former roll. 
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4.3.2 Re-Admissions Form 

The Re-Admissions Form can be printed for timetabled students who have been removed from 
their cohort by clicking on the bin when moving them to the Former Roll.  
 

Activity:  

Timetabling > Reports > O&M  Reports –Students > Re-admissions Form 

 Ensure the date range captures Linda So’s Leaving Date 

 Click Find and select Linda So 
 

 
 

 Click Print 
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4.3.3 Moving Multiple Students to the Former Roll 

Activit 

Cameron and Kane Smith are moving to Jurien DHS.  Move them to the Former roll. 

Admin > Speed Edit 

 Select the Area: Destination   
 

 
 

 Click Select Students  

 Type Smith in the Surname/Ref . No field 
 

 
 

 Find the siblings Cameron and Kane Smith 

 Highlight both students 
 

 
 

 Click Select then Yes 
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 Highlight both students in the Speed Edit window 

 From the New Value menu, find Jurien DHS 
 

 Click Apply Changes   

 Click Save, then Yes 
 

 
 

 Change the Area drop down menu to Leave Date  
 

 
 

 Enter TODAY’s date in the New Value field 
 

 
 

 Highlight both students 
 

 Click Apply Changes   

 Click Save 
 

 
 
 

 Click Yes 

 Close Speed Edit 
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Admin > Utilities 

 
 

 Double-click Current Roll > Former Roll 
 

 
 

 Enter TODAY’s date as the students’ Leave Date 

 Click OK to moving the students  

 Click Yes confirm you want to move them on these dates 
 

 
 

 Click Yes to remove students from their Groups 
 

 
 
 

General > Student Details 

 Locate Cameron  and Kane Smith on the Former roll 
 

Note: Moving students to the Former roll in groups does not allow the option of saving a 
record of their teaching sets. 
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4.4 Assigning Schools Curriculum and Standards Authority (SCSA) 
Student Numbers 

School Curriculum and Standards Authority Student Numbers (Previously Curriculum Council 
Numbers) can now be assigned to students up to and including Year 7’s through the Admin > 
Utilities window. 
 
Opening this Utility allows you to apply SCSA Student Numbers to a year group. 
 

Activity 
 
The Year 7 students do not have their SCSA Student Numbers.  Before running the utility, we 
will check to make sure they have not been applied. 
 
General > Student Details 
 

 Click Student Search  

 Load all the Year 7’s as a browse set 
 

 
 

 Scroll through and view the student numbers are 00000000 
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Activity 

Admin > Utilities > Student Number Import 

 

 
 

 Select Year 7 from the drop down list and click OK 
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 Click Yes 
 

 Navigate to C:/keys/Integris/Inbox/StudentNos 
 

 Highlight the 7CCNos text file and click Open 
 

 
 
 

 
 

 Click OK to the Validation message 

 The import will commence 
 

 
 
 

 
 

 Click OK 

 View the Year 7s SCSA Student Numbers through Student Details 
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5 Exporting and Importing Student Data 
It is important that all schools use the SIS School to School Export and Import processes to enrol 
new students. 
 
It is possible to electronically export and import student data without losing any information or the 
information being overwritten. 
 
The data transfer procedure consists of 2 steps 
 
Step 1  Feeder school completes the School to School Export of student administration data.  This 
file is emailed to the receiving school for importing. 
 
Step 2  Receiving school completes the School to School Import of student administration data. 
 
When student data is received from another school, you are given options regarding the retention 
of the data that already exists in your datafile.  There are three checkboxes available in the Import 
Transfer File window.  These determine how the data is matched to student records that exist in 
the datafile and what data is retained or overwritten according to the selections made. 
 

 
 
Replace all Contacts and related detail when updating existing Students –recommend leaving 
this un-checked.  If the student already exists in the datafile, it is unlikely that the details in the 
import file are more current than those in your datafile, unless the student has been reinstated from 
the Former Roll and not had their contact details updated. 
 
Match Students on UPN only-recommend leaving this un-checked.  
 
Extended Checking- recommend checking this box.  This function will look for similarities 
between student records based on a combination of gender, date of birth, the first two letters of the 
first name and the first two letters of the surname.  When a potential duplicate has been found, the 
Extended Checking window will display.  The window provides the user with options for importing 
or rejecting the student record.  During processing, an activity log displays the progress of the 
import of each record.  The activity log can be saved or printed. 
 
Student data can be transferred from primary to secondary schools well before the end of the 
academic year.  This enables the secondary school to undertake activities associated with the 
creation of the following year’s timetable and in producing a charges and contributions sheet. 
 
In all cases, students should be enrolled onto the Admissions Roll and then transferred to the 
Current Roll upon arrival at the destination school.  The exception to this rule is only if the student 
already exists in the datafile, either on the Former or Current Roll 
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Items in the Transfer File include: 

 Student personal details (entry date, address, DOB, etc) 

 Student additional information (Indigenous Status, religion etc) 

 Medical information (sensitive information is not included and a message is displayed 
indicating the student has a flagged medical condition) 

 Contact details for parents and emergency contacts 

 Previous school (if entered when importing the data) 

 Behaviour records (if the exporting school has ticked the  box for behaviour 
records). These records will be in grey in the Behaviour Management screen for the student  

 If using the Student Details XML Export Utility, schools may elect to export ALL Behaviour 
Records or only those marked as Retain on Transfer 

 Attendance records summary 

Note: Student Photos are not included in the Import/Export process. 

Transfer of data between primary and secondary schools in preparation for end of year 

Student data is usually transferred to the secondary school well before the end of the academic 
year. This enables the secondary school to undertake activities associated with the creation of the 
following year’s timetable and the production of contributions and charges information.  This means 
that the process may be spread over a number of terms. 
 

Transfer between schools during the year 

The process is used when a student or students move between schools during the school year. 

Note:  In all cases, students should be enrolled onto the Admissions Roll and then 
transferred to the Current Roll upon arrival at the destination school. 
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5.1 Exporting Student Information 

5.1.1 School to School Export 

Activity 

Admin > Utilities 

 
 

 Double  click on School to School Export 

 Enter the Destination of Jurien DHS and TODAY’S date as the Date of Leaving 

 Ensure each of the Export options are checked 
 

 
 

 Click OK 

 Give the export file a name, for example West Coast DHS to Jurien DHS_Smith family 

Note: This is the Department of Education’s recommended protocol for naming Admin 
export files. 

 
 

 Click Save 
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 Click Yes  
 

 
 

 Click OK 
 

The export file may now be sent to the destination school as an email attachment.  It would be 
helpful to provide the school with a list of the students whose data is being exported. 
 

 Close the Transfer window by clicking Cancel 

Note: This activity can be completed because the Smith family had already been given a 
Leave Date, Destination and moved to the Former Roll. 

 

 

5.1.2 Students Details XML Export 

Usually a school will export student data using the School to School Export function as outlined 
above.  The Student Details XML Export allows student details to be exported without students 
requiring a leave date or destination, that is the students remain in the system but their export file 
can be emailed from the location to which it has been saved. 
 
Schools can elect to do a Full Export or Partial Export of student data if using the Student Details 
XML Export. If selecting a Partial Export schools may choose to export ALL Behaviour Records or 
only those that have been marked as Retain on Transfer.  
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Activity 

Admin > Utilities > Student Details XML Export 

 
 

 Click  

 Enter the following information to locate Linda So 
 

 
 

 Click Find  
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 Click Next 

 Select Partial Export  

 Check Attendance History and All Behaviour Records 

 Enter the Destination of Northampton D.H.S  
 

 
 

 Click Export 

 The export file should be saved to the outbox 
 

 
 

 Give the export file a name, for example West Coast DHS to Northampton DHS_Linda So  

 Click Save 
 

 Click Yes to recalculate the Attendance figures 
 

 
 

 Click OK and close the Transfer window by clicking Cancel 
 
The export file may now be sent to the destination school as an email attachment. 
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5.2 Importing Student Data 

5.2.1 School to School Import to the Admissions Roll  

Activity 

Admin > Utilities > School to School Import 

 
 

 Highlight the file Ravensthorpe DHS to West Coast DHS_Alan Grant and click Open 

 Leave Admissions selected 
 

 
 

 Click Add   

 Give the Batch an appropriate name and click OK 
 

 
 

 Leave the Entry Date as TODAY 

 Check Extended Checking (this ensures that possible duplicate records may be displayed) 
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 Click OK 
 

 
 

 Click OK at the conclusion of the import process 

 Print the import log to the screen 
 
At school this information could be saved as a hard copy of the import routine. 
 

 Close the Import Log and Utilities 
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5.3 Moving Students to the Current Roll 

Activity 

General > Student Details 

 Locate Alan Grant on the Admissions roll    
 

 
 

 Click Edit  

 Enter his Form and new address and telephone details as shown below 

 Check Accepted   
 

 
 

 Click OK 
 

 
 

 Click Yes 

 Close Student Details 
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Admin > Utilities 

 Double click Admissions Transfer > Current Roll 
 

 
 

 Select the second option (ignoring  any entry dates) and leave TODAY as the Entry Date 

Note: If the first option is selected, only those accepted admissions students whose Entry 
Date matches the date of entry will be transferred to the current roll. 

If the second option is selected, ALL accepted admissions students will be transferred to 
the current roll and any Entry Date previously entered will be ignored and be replaced by 
the date entered in this window. 

 Click Next 
 

 

Note: Students can be deselected from this window if they have not arrived at school 

 Click Finish and OK 

 Click No as we will not check for empty batches  
 

General > Student Details 

 Locate Alan Grant on the Current roll 
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5.3.1 School to School Import to the Current Roll  

Activity 

Admin > Utilities > School to School Import 

 
 

 Select the file for Tapping to West Coast_Joshua Burnett and click Open 

 Change Import into to Current Roll 
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 Leave the Entry Date as TODAY 

 Check Extended Checking (this ensures that possible duplicate records may be displayed) 

 Click OK 
 
The Extended Import Checking for Possible Duplicates window appears, showing any possible 
duplicate students that the important function has found. 
 

 Highlight the student shown 
 

 Select Import into the selected existing student record, retaining the existing core 
details 

 

 
 

 Click OK 
 

 
 

 Click OK to Import Complete 

 Close the window 
 
A hard copy of the Transfer File may be printed by clicking the Print button 
 

General > Student Details 

 Check that Joshua Burnett's information has been updated and that he now has a Lesson 
Attendance history. 
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5.4 Advanced Admissions Batch Entry 

Advanced Admissions Entry enables users to enter students in batches and then transfer the batch 
from the Admissions Roll to the current roll.  Multiple students can be added to the batch as they 
apply for admission to the school.  It is recommended that only basic information be entered in  
Advanced Admissions in event the student does not end up attending.  The transfer process allows 
for the deselection of the student in the Transfer window if they have not arrived on their due start 
date and they will remain in the Transfer window until they either eventually arrive at the school or 
notification has been received that they will not be attending, whereby they can then be removed 
from the admissions list.   
 

Activity 
 
There are two ways in which students can be entered using the Advanced Batch Entry function.  
The first option involves entering and editing details. 
 
Madeline Crean is enrolling for next term.  Her half-sister Helen Baverstock is already enrolled at 
the school.  They have different fathers. 
 
Admin > Admissions 
 

 Double Click on Admissions Batch Entry 
 

 
 

 Click Add Batch  
 

 Enter 2019 Term (Next Term number) 
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 Click OK 

Click Advanced Admissions Entry  
 

 Enter Crean in the Surname field 
 

 
 

 Press <Tab> to move between the fields and the Choose Sibling window will display 
 

 
 

 Use Student Find to locate Helen Baverstock 
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 Click to copy Helen Baverstock’s details 

 Continue to enter Madeline’s details as shown below 
 

 
 

 Click on the Parent Guardian 1 Tab 

 Change the Relationship to Stepmother for Hazel Baverstock 
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 Click on the Parent Guardian 2 Tab and edit the details as shown below 
 

 
 

 Click OK to Save 
 

 
 

 Click OK 
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Note:  Data can be edited by using the Advanced Admissions Edit .  Data can also be 
edited via Student Details > Admissions Roll. 

The second option for entering students using the Admissions Batch Entry Function, is a quick 
way of entering bulk students using minimal information. 
 
 
Admin > Admissions  
 

 In the Student Details window, click Add Student  
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 Enter the details as shown below 
 

 
 

 <Tab> or <Enter> to drop the details into the bottom window 
 

 
 

 Highlight a student to view their details or edit if necessary 
 

 
 

 Close the Admissions Batch Entry Window 
 

 
  



 
Integris Advanced Admin Manager Training Notes 22-Jan-19 

Page 81 of 140 

© 2019 Civica Pty Ltd 
 

5.5 Moving Admissions Batch Students to the Current Roll 

Activity 
 
Madeline Crean and Emma Pearce have been accepted as students at West Coast District 
High School.  
 
Admin > Speed Edit 
 

 From the Area menu, select Acceptance Status (Admissions) 
 

 
 

 Click the   and select the Admissions Roll   

 Click  

 From the list of students, highlight Madeline Crean and Emma Pearce 

 Click Select and Yes 

 Highlight both students 
 

 
 

 Tick the New Value box 

 Click Apply Changes  

 Click  and Yes and Close 
 

Note:  Accepting students can also be done through Student Details > Admissions Roll 
and ticking the Acceptance box on each Individual record. 
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Admin > Utilities 
 

 Double-click Admissions Transfer Current Roll  
 

 
 
 

Select the second option (ignoring Entry Dates) and leave today as the entry date.  

Note: If the first option is selected, only those accepted admissions students whose 
Entry Date matches the date of entry will be transferred to the current roll. 

If the second option is selected, ALL accepted admissions students will be 
transferred to the current roll and any Entry Date previously entered will be ignored 
and be replaced by the date entered in this window. 

 Click Next 
 

 
 

 Click Finish 

 Click Ok to the Transfer Complete message 

 Click No as you do not wish to check for Empty Batches 
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6 The External Roll 
It is possible to enter essential information on visiting students who may come to a school for 
various periods or activities on a regular basis, but who are not actually enrolled at the school. 
 

 
 
When the external roll has been activated, it is possible to search the External Roll from the main 
student window or through the Find Student function   
 

 
 

6.1 External Roll Active 

Activity 

General > Control > Preferences > General tab 

 Check External roll active for students 
 

 
 

 Click OK 
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6.2 Adding a Student to the External Roll 

Activity 
 
Justin Badley is attending PEAC at the West Coast Community College. He needs to be added 
to the External Roll and flagged as a part-time student. 

General > Student Details 

 Select the External Roll  
 

 
 

 Select Add Student  
 

 On the Personal tab fill in the following information: 

o Surname: Badley 

o He has no siblings at the school – Cancel the choose siblings window 

o First Name: Justin 

o DOB: 24/3/2008 

o Gender: Male 

o Year: 7 

o Form: Form 7 

o Address: 125 Watershed Road, FORRESTFIELD, WA, 6587 

o Telephone: 08 9658 2154 
 

 On the Family Group, Parent/Guardian 1 tab fill in the following information: 

o Title: Mr 

o Initial: T 

o First Name: Travis 

o Relationship: Father 

o Gender: Male 

o Tick all four check boxes relating to parent information 

o Mobile Number: 0412 568 458 

o Salutation: Mr Badley 
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 On the Additional tab, check Australian Citizen/Permanent Resident   

 Set the FTE to 0.20  

 Select Custom 
 

 

 Click Assign Part Time Pattern   
 

 Set Tuesday and Wednesday mornings as the Attendance pattern 
 

 
 

 Click OK  and OK to Save 
 

 
 

 Click NO to continue to edit the record 

 Change the Vaccination Schedule to Not Provided 
 

 
 

 Click OK to save the record 
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7 Mail Merge 

7.1 Introduction to Mail Merge 

Integris provides users with a letter writing facility as part of the Student, School and Staff Details 
sections of the software.  
 
There are two ways that Integris can create mail-merged documents.  

Option 1 

The first is by way of using mail merge fields available through the database.  The Integris 
database is supplied with a mail merge function whereby administrative details such as students' 
names and addresses can be dynamically embedded into a MS Word template.  These can then 
be saved as school letters. The letter templates are created before using the Send Letter function 
in Student Details.  

Option 2 

The second way is to create an export file into MS Word, which then allows users to use the MS 
Word mail merge functions to create their letters or other documents such as address labels.  

Selecting Students and Merging System 

When you are ready to send a letter, decide to whom the letter will be sent. If the letter is to be sent 
for one student, load their records in Student Details.  If the letter is to be sent for a group of 
students, use the Find Student function in Student Details to create a browse set of students.  
When the user has selected the student/s in Student Details and the Send Letter button is clicked, 
a Mailing Options window is displayed. 
 

 
 
Make selections as appropriate.  If using the .kst method, the template has to be created prior to 
clicking Send Letter.   
 

 
 
Letters to be sent to all contacts flagged as Family Mail Markers: If *.kst file merging is being used, 
this may result in multiple copies of the letter being produced for each student  if more than one 
contact is flagged as Family Mail Marker.  If a *.csv file is being exported, several record lines may 
be included in the file for each student (one for each Mail Marker contact).  
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Note: Other Contacts can be flagged as Family Mail Markers as well as Parent/Guardians. 

The Family Mail Marker field should be enabled if letters are to be sent to the person at this 
address.  If you use this field, make sure you complete the Salutation.  Enter the salutation that is 
to be used when writing a letter to this person.  It is also displayed on some reports. 
 
If a student has details of both parents recorded, with only one parent/guardian nominated as a 
family mail marker. The salutation field will need to be completed for the nominated parent e.g. ‘Mr 
and Mrs Allen’.  This will be available as a mail merge field to start a letter “Dear Mr and Mrs Allen”.  

Note: If letters are to contain Family Mail Marker information then the letter template must 
contain ‘Addee’ fields and the box ticked for ‘Send to all contacts marked as Family Mail 
Marker’ (see screenshots below). 
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7.2 Mail Merge: kst format 

Using the kst method, the user creates a letter template prior to selecting contacts to whom the 
letter will be sent.  This method is useful for printing small numbers of letters.  If letters are to be 
merged for a large number of students, use the Export method (Option 2). 
 

7.2.1 Creating a kst Template  

 Open Microsoft Word 

 Click Open Document  

 Navigate your way to the K:\Keys\Integris\MMTPL\Letters folder 

 Open the Student.kst document that is supplied with the software.   
 

  
 
This can be used to copy merge fields into the letter template you are creating. 
 

 Open a new Microsoft Word document (This will be used for the letter template.) 

 Type the body of the letter. 
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 Enter the merge fields for your letter template using the field names in the Student.kst 
document for any Integris fields you want included in the letter.  

 Save your document with .kst extension in quotation marks, for example  “Student Letter.kst” 
 
This letter template should be saved to an appropriate folder within your school network, for 
example to a shared drive where all templates are stored. 
 
When the template is complete, it will be available to all users with access to the drive where the 
template is stored. 

Note: When creating .kst Templates, users are advised NOT TO USE Numbered Bullet lists 
as these will cause the Template to be corrupted.  Numbers must be typed in, rather than 
inserted using Numbering or Bullet Lists. This issue is with MS Word kst Templates. 

 

Activity 
 
A sample letter can be found on page 17 of the Administration Manager Supplement. 
 

 Navigate to C:\Keys\Integris\MMTPL\Letters to open Student.kst 

 Open the document Sample Transfer Note also located in 
C:\Keys\Integris\MMTPL\Letters  

 
Text has been entered but the merge fields need to be added. 
 

 Type Previous School above the black line 

 Copy <PrevSch> from Student.kst and paste it at the top of your Transfer Note 
 

 
 

 View how <Surname> appears in Student.kst 

 Type <Surname> into your Transfer Note 
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Note: When typing in merge fields, they must appear exactly as they appear in 
Student.kst. 

 Continue to copy and paste, or type merge fields into your transfer note (Hint: Use the 
example in the Administration Manager Supplement on page 24). 

 When all merge fields have been added File > Save As 

 Enter the file name as "Transfer Note.kst" 
 

 
 

 Click Save 
 

 

7.2.2 Using the kst template to create letters 

General > Student Details 

 Load a browse set of students to whom the letter will be sent  

 Click Send Letter   

 Select the “.kst” option   

 Make other selections as appropriate 

 Click OK  

 Navigate your way to the folder where the letter template has been stored 

 Double click on the name of the template, for example transfer note.kst  
 
If any editing needs to take place: 

 Open MS Word and open the template document 

 Make and save any changes, close the template and use it again 
  



 
Integris Advanced Admin Manager Training Notes 22-Jan-19 

Page 91 of 140 

© 2019 Civica Pty Ltd 
 

 

Activity 

General > Student Details 

Send Transfer Notes for the students who started at West Coast District High School this year. 
 

 Find  the students with an entry date of this year. 
 

 
 

 Click Send Letter  

 Select the following options 
 

 
 

 Click OK 

 Select Transfer Note.kst 

 Click Open 

 Check the Transfer Note has merged correctly 
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 Click Yes 

 View the Transfer Notes 

 Close the Transfer Notes 
 
DO NOT CLOSE WORD 
 

 Click Student Activity  

 View the new students’ records 
 

 
 

 Highlight the Transfer Note and click Print 
 

 
 
Details for the Transfer Note are displayed 

 Close the Transfer Note and click  Open Sent Letters in MS Word 
 

 Close Student Details 
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7.3 Mail Merge using csv format 

General > Student Details 

The second mail merge option is to create an export file which then enables users to use the MS 
Word mail merge functions to create their letters or documents.  This method is faster than the .kst 
method when creating merged documents for a large number of students. 
 

7.3.1 Create an Export (.csv)  File 

 Find the student/s for whom you wish to send  a letter 
 
This creates a browse set. 
 

 Click Send Letter  in the Student Details window 
 
The Mailing Options window opens. 
 

 Select the CSV option 
 

 
 
Click OK 
 

 
 

 Name the file and save it to an appropriate location 

 Click OK 
 
This file can now be used in Microsoft Word, or other word processing packages, to create letters, 
labels or other merged items. 
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Activity:  

General > Student Details 

 Find  the Senior Choir 
 

 
 

 Select All the  students from the list 
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 Click Send Letter  

 Select the following options 
 

 
 

 Click OK 

 Name the export file Senior Choir 

Note: The file defaults to save in the Integris Outbox, however you can save the file 
wherever you wish. For training purposes you may use the Desktop. 

 
 

 Click Save  
 

 
 

 Click OK 
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7.3.2 Creating a Mail Merge Letter in Word 

Activity 
 
A sample letter can be found in the Administration Manager Supplement on page 22. 
 

 Open a new Microsoft Word document and type the letter 

 Click on the Mailings Menu 
 

 
 

 Click on the small arrow at the bottom of the Start Mail Merge icon 
 

 
 

 Select Letters 

 Click on Select Recipients and choose Use Existing List 
 

 
 

 Browse to the csv file on your desktop 
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 Highlight and Click Open or Double Click 

 Click the Edit Recipient List icon 
 

 
 

 
 

 Click OK for all recipients or select those required 
 
You are now ready to start creating your letter 
 

 Place your cursor where you want the first address line in your document to appear 

 Click on the small arrow at the bottom of the Insert Merge Field icon 
 

 
 
All available Mail Merge fields will show in this list.  
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 Click on AddeeSalutation 

 Move your cursor to the next line 

 Click on the small arrow at the bottom of the Insert Merge Field icon 

 Click on AddeeAddL1 
 
Use the Sample on Page 22 of your Supplement to insert the remaining merg fields.  
Click Preview Results when you have completed your letter 
 

 
 
You can preview other letters by scrolling through the recipients with the scroll arrows. 
 

 
 
If there are mistakes in your letter: 
 

 Click Preview Results again and make any changes required 
 
When you are happy with your letter: 
 

 Click on Finish and Merge 

 Select Edit Individual Documents 
 

 
 

 Click OK for All 
 

 
 

 View your merged letters 

 Close the letters but do not close word 
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7.3.3 Using the Mail Merge Wizard 

If you are accustomed to using the Mail Merge Wizard available in Word 2003, the same Wizard 
can still be used. A summary of those steps are outlined below. 
 

 Select Step by Step Mail Merge Wizard from the Start Mail Merge Icon 
 

 
 
The Mail Merge Wizard will open on the right hand side of the document 
 

 
 

 Select the document you require and Click on Next: Starting document 
 

 
 

 Click Next: Select Recipients 
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 Ensure Use an Existing List is selected and click on Browse 
 

 
 

 Navigate to where you have saved your data source and Open the file 
 

 
 
  



 
Integris Advanced Admin Manager Training Notes 22-Jan-19 

Page 101 of 140 

© 2019 Civica Pty Ltd 
 

 View your Recipient List and select the recipients required and click OK 
 

 
 

 Click Next: Write your letter 
 

 
 

 To Insert Mail Merge Fields click on the link to More Items 
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The available fields will display 
 

 

Note: Fields can be inserted by double clicking or highlighting and clicking Insert. If you 
need to re-position your cursor in the document, you must close this window, move your 
cursor and click on More Items again. 

Once you have inserted all your items and typed your document: 
 

 Click on Next: Preview your Letters 
 
You can scroll through and view all recipients’ letters or edit the recipient list at this point. 
 

 
 

 If you find errors, click Previous: Write your letter  
 

 
 
This allows you to return to the previous page to edit the letter. 
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If you are ready to finish the Mail Merge: 
 

 Click Next: Complete the merge 
 

 
 
Letters can be printed at this point. If you wish to open the letters as a new document: 
 

 Click on Edit individual letters 
 

 
 
You can open All Letters or select particular letters if you know which recipient you wish to edit. 
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7.3.4 Create Student Activity Record for Letter Sent 

Producing a Mail Merge data source for MS Word does not result in an activity record in Integris.  
We can use a short kst letter to create an Activity Log Record 
 

Activity:  
 

 In Word type a short letter similar to the one below 

 Make sure you include <FirstName> and <Surname> as Mail Merge Fields using <> 
 

 
 

 Save the letter on your Desktop as “Mail Merge letter Choir Festival.kst”  
 

General > Student Details 

The Senior Choir Browse Set should still be there. 

 Click on Send Letter  

 Select the options below 
 

 
 

 Click OK and navigate to where you saved the Mail Merge Choir Festival.kst letter 
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 Click Yes  

 View the Students’ Activity Logs 
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7.3.5 Create Address Labels 

It is possible to create Address Labels for the students for whom you have created the mail merge 
documents or letters. 
 

Activity  
 

 Click on the Mailings Menu in Word  

 Click on Start Mail Merge and select Labels 
 

 
 

 Make the following selections and click OK 
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 Click on Select Recipients and Use existing list 
 

 
 

 Browse to the csv file on your desktop 
 

 
 

 Double Click or Highlight the file and click Open 

 Click the Edit Recipient List icon 
 

 
 

 
 

 Click OK for all recipients or select those required 
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You are now ready to start creating your labels. 
 

 Click Insert Merge Field 
 

 
 

 Insert the mail merge fields shown below 
 

 
 

 Click   

 Click Preview Results when you have completed your labels 
 

 
 

 Preview other labels by scrolling through the recipients with the scroll arrows 
 

 
 
If there are mistakes in your labels: 
 

 Click Preview Results again and make any changes required 
 
When you are happy with your labels: 
 

 Click on Finish and Merge 

 Select Edit Individual Documents 
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 Click OK for All 
 

 
 

 View your merged labels 
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8 User Defined Information 
User Defined Information (UDIs) is used for storing any information specific to schools that does 
not already have a field in Student Details.  It could be anything from Indigenous Language Groups 
to Internet Permissions.  Once UDIs have been created they can be used to report on and find 
students. 
 
It is also possible to set up and maintain Staff and School UDIs. 
 

8.1 Create a UDI 

Note: To create a UDI, it is necessary to be in Single User mode. 

Activity 

File > Single User Lock 

 
 

 Enter your password 
 

 
 
If other users are logged in their details can be displayed in View Users so that the administrator 
can ask them to exit the system. 
 

 Click OK 
 

This icon appears under the Menu Bar:   
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Create a field to record permission to use students’ images in various media.  

General > Control > UDI Definitions 

 
 

 Double click Student UDI 

 Right click in the white pane under the Field Name heading 
 

 
 

 Select Add Field 

 Enter the Field Name: Imagepermission 

Note: Field Names cannot have spaces. 

 <Tab> 

 From the drop-down menu,  select Lookup 

 Click Edit  

 Type Yes and <Tab>  

 Type No and <Tab> 

 Type Contact Parent and click OK 
 

 
 

 Enter the Description: Image Permission 
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 Check Index 
 

 
 

 Click OK  
 

 
 

 Click Yes 

Note: While a UDI cannot be deleted, it can be edited or disabled. 

 

Return to Multi-user mode 

 Click Single User Lock  

 Click Restore Multi-user 
 

 
 

 Type your password 

 Press <Enter> or click OK 
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8.2 Speed Edit UDI 

Speed Edit the UDI Image Permission for all Year 9 students. 

Admin > Speed Edit 

 Select **Student UDI Fields** from the Area menu 
 

 
 

 Select Image Permission  from the UDI Field menu 

 Find    the Year 9 students 
 

 
 

 Click Find, Select and Yes to load all students into the Speed Edit window 

 Highlight some of the students  in the list 

 Select Yes from the New Value menu 
 

 

 Click Apply Changes   

 Enter No or Contact Parent or leave Blank for the remaining students 

 Click Save and Yes 
 

General > Student Details 

 View the UDIs  for the Year 9 students 
 

 
 
  



 
Integris Advanced Admin Manager Training Notes 22-Jan-19 

Page 114 of 140 

© 2019 Civica Pty Ltd 
 

8.3 Ad Hoc Reports 

Admin > Reports > Ad Hoc Reports > Ad Hoc Manager 

Users can create their own reports using the Ad Hoc section under the main reporting menu. 

Highlight the Ad Hoc Reports folder and click on the  button that appears on the 
right-hand side of the window.  
 

  
 

To create a new report, click on the Ad Hoc Wizard icon.  This will take you through the Ad-
Hoc Wizard function, asking you to select what data you wish to include in your report and how you 
wish to sort it.  Once you have progressed through all the Wizard windows, you will be asked to 
create your report.  This takes all the fields you have specified and displays them in the design 
window, enabling you to make changes to the layout of the report: 
 

 
 
It is here that field lengths can be extended, text styles can be changed and fields can be 
rearranged, added or deleted to change the whole layout of the report. 
 
Closing the design window saves the set-up and brings you back to the Ad Hoc Manager window 
where all the reports created will be displayed. 
 

Use the  buttons to change the view of the ad hoc reports. 
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Reports can be: 

 modified using Modify Report   

 copied using Copy Selected Report  

 renamed using Rename Selected Report  

Note:  It is a good idea to copy a report and give it a new name before making changes to 
the report. 

Once reports have been defined they are run in the same way as standard reports. 
 

 Open the Ad Hoc Reports folder 

 Highlight the report  to be printed 
 

 
 

 Use New Query to load the Student Search window and select students or load a saved query 

 Print the report 
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8.3.1 Simple Ad Hoc Reports 

Activity 

Admin > Reports > Ad Hoc  Reports 

Create an Ad Hoc report displaying student’s names, Forms and the UDI Image Permission.  
Sort by Form and display each form on a separate page. 
 

 Click Ad Hoc Reports 
 

 
 

 Click Ad Hoc Manager 

 Click Ad Hoc  

 Enter the following information 
 

 
 

 Click Next 
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Check the following fields: 

o Form 
o Name: First Name 
o Name: Surname 
o UDI: Image Permission 

 

 Click Next 

 Leave the Selection Criteria as ALL 

 Click Next 

 Select the following Print/Sort Options: 
 

 
 

 Click Next 

 Highlight Name: Surname and click Up to create the following print order 
 

 
 

 Click Next 

 Click Create 

 Click the column header (in bold) Form 

 Change the font size to 12 

 With Form still selected, click Text Colour  

 Double click Name:  Surname and change it to Surname  

 Change the font size to 12 and select a suitable colour  

 Continue to format the remaining column headers 
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 Close Ad Hoc Report Designer and Ad Hoc Manager 

 Open the Ad Hoc Reports folder 

 Select the report Image Permission 
 

 
 

 Click New Query 

 Find the students  in Year 9 

 Print the report  to the screen 
 

Note:  To make any further changes, close the report and return to Ad Hoc Reports > Ad 
Hoc Manager. Double click on the report name to open it. 

 

8.3.2 Normal Ad Hoc Reports 

These reports are used when the following fields are required in a report: 
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Activity 

Admin > Reports > Ad Hoc  Reports > Ad Hoc  Manager 

Create a Normal report for Contacts information, including the students’ First Names, Surnames 
and Forms. 
 

 Select Ad Hoc Reports  

 Click Ad Hoc Manager  

 Click Create a new report  

 Enter a Report Name and Description 
 

 
 

 Select Normal Report 

 Click Next 

 Select Contacts 
 

 
 

 Click Next 
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Select the fields: 

o Form 
o Name: First Name 
o Name: Surname 

 

 Click Next 

 Leave the Selection Criteria at All and click Next 

 Make the following selections 
 

 
 

 Click Next 

 Select the following Print Order: Form, Surname, First Name 

 Click Next 

 Click Create 
 

 In the Ad Hoc Report Designer window, format the report as you wish 
 

 Close the Ad Hoc Report Designer window and the Ad Hoc Manager window 

 Print the report for students in Year Group 8 
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9 Admin Reports 
There are many reports available in Integris.  We will view a few that may be particularly useful. 

9.1 General Reports  

9.1.1 Medical Conditions 

Activity 

Admin > Reports > General Reports > Medical Conditions 

 Sort by Form 

 Check Include Daily Management Plan 

 Select all students on the Current Roll 
 

 
 

 Print the report  to the screen 
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9.2 Roll Reports 

9.2.1 Parent/Guardian 1 Phone and Address 

Admin > Reports > Roll Reports > Parent/Guardian 1 Phone and Address 

 Sort by Form 

 Tick Total and Page for Form 

 Select all students on the Current Roll 
 

 
 

 Click Print 
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9.3 Form Lists 

9.3.1 Student Information Card 

Admin > Reports > Form Lists > Student Information Card 

 Click New Query, find the Year 6 students 
 

 
 

 Click Print  
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9.4 Check Lists 

9.4.1 Group Checklist 

Activity 

Admin > Reports > Checklists > Group Checklist 

 Enter the following information 
 

 
 

 Print the report  to the screen 

 Close the report, but not the report  definition 
 

 Click Save as Custom Report   

 Rename the saved Checklist to Interschool Sports Checklist 
 

 
 

 Click OK 

 Click Allow Custom Report to be used by others   
 

 
 Close the Checklists and Saved Checklists folders 
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9.5 Address Labels 

9.5.1 Family Mail 

Activity 

Admin > Reports > Address Labels > Family Mail 

 Select Standard Labels 8x3 

 Use New Query drop down list to select the saved query Family Rep’s 
 

 
 

 Print to the screen 
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9.6 Exports 

Activity 

Admin > Reports > Exports > Parent/Guardian Email Export 

 Select Export the Email Address for all marked as Family Mail Marker 

 Use New Query to find Year Group 7 
 

 
 

 Click Print 

 Select the desktop to Save the Export file 

 Click Save and OK 

 View and Close the exception Report. 
 
This Report displays any students where no email addresses were located in the student record. 
 

 Navigate to your desktop to open and view the file 

Note: The Export file defaults to save to the Outbox but can be saved in any location. The 
Export file may be opened and viewed in Microsoft Excel. Email Addresses can be copied 
from the excel file and pasted into the “To” box of your email client (e.g. Outlook) 
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10 Timetable Reports 

10.1  O&M Reports-Teaching Sets 

10.1.1 User Defined Teaching Set Lists 

Activity:  

Timetabling > Reports > O&M  Reports –Teaching Sets > User Defined Teaching Set Lists 

 Select the radio button Teacher 

 Select Harris Barclay 
 

 
 

 Click the Sort tab 

 Sort by Subject 
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 Select the Includes tab 

 Check Student Form, Parent/Guardian Name, and Parent/Guardian Phone 

 Enter 6 in Number of Columns 
 

 
 

 Print the report  to the screen 

 View then close the report 
 

 Run the report again, however select Department or Subject/Teach Set from the Select tab 
and choose from the Department list or the Subject/Teaching Set list. 
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11 WA Reports 

WA Reports > Reports > WA Reports 

 
 

WA Reports can be accessed from the Sidebar or from the Student Profile Icon  on the top 
toolbar.  If activating from the Student Profile icon the software will default to open that report. 
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11.1.1 Standard Student Checklist 

It is possible to create checklists in WA Reports for Forms, Year Levels, Groups or Teaching Sets.   
A check list can be created to cover multiple groups of students, which is done through the 
Advanced Search function.  This allows the user to customise the report to suit their purpose. 
 

Activity:  

WA Reports > Reports > WA Reports > Standard Student Checklist (Using the Advanced 
Search function)  

 

 Select the Standard Student Check List 
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 On the Layout Tab enter a suitable name for the report 
 

 
 

 On the Sort Tab double click Year and check Total and Page  

 Double click on Sex and Surname 
 

 
 
 
 
 

  



 
Integris Advanced Admin Manager Training Notes 22-Jan-19 

Page 132 of 140 

© 2019 Civica Pty Ltd 
 

 

 On the Select tab, click the Student Find radio button  
 

 
 

 Click on New Query 

 Find the Group Type 2019 Music  and Group 2019 Senior Choir  
 

 
 

 Click Find 

 On the Search Results Screen click on Advanced Find  
 
This saves the first search and allows you to add another. 
 

 Click Add  

 Find the  Group 2019 Junior Choir 
 

 
 

 Click Find, Select and Yes 
 
The Junior Choir Students have been added to the group. The Advanced Find can be used 
again to select more students if required. 
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 Click Select and Yes 
 
The Senior and Junior choir are now added to the group 
 

 
 

 Click Select and Yes 
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 On the Includes tab, check Student Sex and Student Form 

 Enter the Column Labels and Widths as shown 
 

 
 

 Print the report  to the screen 

 Click on Save as a Custom Report  

 Name the report Choir Festival Checklist and click OK 
 

 
 
The Report is saved in the Custom Report Folder. 
 

 

Note: As Advanced Searches cannot be saved in this version of Integris, only the set up 
in the other Tabs will be saved in this example 
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11.1.2 Student Profile Report 

Activity:  

WA Reports > Reports > WA Reports >Student Profile  

 Click on Student Profile Report Icon   
 
This provides a shortcut to the WA Reports Sidebar and defaults to the Student Profile Report 
 

 
 

 Enter the From date as 01 Feb 2018 and the To date as Today 

 Click New Query 

 Choose Form 8.1 and click Find 

 Highlight the first four students in the list and click Select and Yes 
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 Select the Behaviour Types/Actions tab 
 
All Behaviours are checked by default.  
 

 
 

 Click on the Attendance tab 
 
Show Attendance Details is checked by default. 
 

 
 

 Click on the Activity Types tab 

 Check Show Activity Details 
 

 
 

 Click Print 

 View then close the report 
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11.1.3 Student Health Care Summary (Form 1) 

Activity 

WA Reports > Reports > WA Reports > Student Health Care Summary 

 Click on New Query 

 Select all the students in Year Group K 

 Type in a footer message 
 

 
 

 Click Print 

Note: Printing this form through the WA Reports will not create a letter sent in the 
student’s activity log record. 
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13 Support 
Should you require support please contact the Customer Service Centre (CSC) at the 
Department of Education. 
 
Contact details below: 
 

13.1 Phone (CSC) 

Metro: 9264 5555 
Country: 1800 012 828 
 
Please be prepared to supply your ID number, contact details and a brief description of the 
problem. 
 

13.2 Fax (CSC) 

9264 4701 
 
Please include your ID number, contact details and a brief description of the problem. 
 

13.3 Email (CSC) 

customer.service.centre@education.wa.edu.au 
 
Please include your ID number, contact details and a brief description of the problem. 
 
 

14  Online Manuals and Training Notes 

14.1 Civica 

Online manuals and training notes are available to download in PDF format from the Civica 
Education website. 
 
www.civicaeducation.com.au 
 
Select online manual login. 
Username: school 
Password: help 
 

14.2 STIMS Project 

The Department’s Student Information Management Project (STIMS) website has numerous fact 
sheets and support documents for all SIS Administration modules. 
 
http://www.det.wa.edu.au/intranet/stims  
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